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Section 1: Introduction 

This manual explains aquatics interfaces with Daktronics matrix displays and includes the  

following sections: 

 

‎Section 1: Covers the basic information about the program and this manual. Take time to  

read the introduction as it defines terms and explains concepts used throughout  

this manual. 

‎Section 2: Briefly explains the setup, configuration and connections involved with the  

OmniSport 2000 timing system. 

‎Section 3: Explains the setup, configuration and connections involved with a  

Colorado Timing Systems. 

‎Section 4: Describes the setup, configuration and connections involved with an  

Omega Timing Systems. 

‎Section 5: Illustrates how to create RTD sequences 

‎Section 6: Offers details about who to contact for help with an application and information  

about the Exchange Program and the Repair & Return Program.  

‎Appendix A: Contains drawings for system applications. 

1.1 Manual Contents 

This manual describes the data entries to send scoreboard data to a Daktronics system. 

Included are instructions for Hy-Tek, TimerInterface 2000, and SwimDive Request II when 

used with Daktronics, Omega, Colorado and generic timers. For other questions concerning 

this system, please contact Daktronics.  

 

Listed below are a number of drawing types commonly used by Daktronics, along with the 

information that each is likely to provide. This manual may not contain all of these drawings. 

Figure 1 illustrates a Daktronics 

drawing label. The drawing number 

is located in the lower-right corner of 

a drawing. In the example, the 

drawing would be referred to as 

Drawing A-69945. 

Please list the model and serial 

number, and the date received in the 

blanks provided on the front page of this manual. When calling Daktronics customer service, 

have this information available to ensure the request is serviced as quickly as possible. 

 

 

 

 

Figure 1: Daktronics Drawing Label 
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1.2 Software Conventions 

The following terms are used to describe various mouse actions that can be used throughout 

this manual. These instructions are based on the standard, right-handed mouse 

configuration. 

Bold 
Any item that requires direct action, such as clicking, pressing, selecting 

or formatting, appears in boldface.  

Italics 

Indicates an item visible on the screen or within a menu. No direct action 

will be taken on this item. Boldface Italics are used to reference other 

manuals, sections within this manual and figures. 

[X] Represents a keyboard key that needs to be pressed. 

“Quotes” Items that need to be typed, including folder and file names. 

Click Press and release the left mouse button. 

Double-click Press and release the left mouse button twice. 

Right-click Press and release the right mouse button. 

> 
A caret indicates to click or move to one menu item after the other, (ex. 

File > Open). 

 

Many OmniSport 2000 timer and Pro software options can be accessed with the keyboard as 

well as the mouse. Where applicable, both mouse and keyboard actions are given to perform 

a command. Many screen buttons have labels that have a letter underlined. Press the key on 

the keyboard that correlates with the underlined letter to activate that particular button. To 

activate secondary buttons, press the underlined key while holding [Shift]. To activate menu 

bar items from the keyboard, press the underlined key while holding [Alt]. 

1.3 Timing Systems 

The timing console determines how the system will be connected. Daktronics has developed 

standard interfaces for the Daktronics OmniSport 2000, CTS (4, 5, 6), Omega OSM6 and ARES 

21. Which sport and the number of pools being used will determine how many inputs will be 

configured in the display control system. 

The main questions are going to be: 

 What type of timing system is being used? 

 How many pools are there? 

 Which sport is being timed?  
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1.4 Results Software 

Information for this manual assumes Hy-Tek MEET MANAGER is being used. If a different 

program is being used instead of Hy-Tek, please consult the software provider and the local 

Daktronics representative. 

Hy-Tek Swim Meet Manager 
Hy-Tek swimming software is used to display and edit events for a swimming meet, 

including seeding, meet program, scoring, reports, and diving events. Hy-Tek‟s MEET 

MANAGER software works with Daktronics equipment using two required add-ons and one 

optional add-on (see below). Existing applications of MEET MANAGER software can be 

updated to include both add-ons, see Hy-Tek‟s website at http://hy-tekltd.com/  

 Timing Console INTERFACE is required to connect MEET MANAGER to timing 

consoles such as the OmniSport 2000, CTS System 6 or ARES 21 consoles. 

 Alpha Scoreboard INTERFACE is required to send start lists, results by heat or event and 

scores to a matrix type display. 

 Pro Network/Internet allows several Hy-Tek computers to be networked together. For 

larger meets where there is a second pool or the top 16 results are displayed, this is a 

necessary add-in. 

1.5 Message Displays/Controllers 

Daktronics message displays are either controlled by Daktronics Venus® 7000 or Venus® 

1500 controller. Venus 1500 systems are more limited but are easier to operate and less 

expensive. In many cases if the customer has a Colorado Timing System (CTS) or Omega 

timing system it may cost less and make the system easier to operate if they update to an 

OmniSport 2000 timing system. Some programs used with message displays are SwimDive 

Request II and TimerInterface 2000.  

TimerInterface 2000 
Daktronics TimerInterface 2000 software is an application that converts Omega Timing 

Systems or Colorado Timing Systems to RTD, which is information that is understood by a 

Daktronics matrix. For additional information, see “Timer Interface Software Manual”  

(ED-12452). 

SwimDive Request II 
Daktronics SwimDive Request II is a program that allows the operator at the Venus 7000 or 

VPlay computer to request information from Hy-Tek‟s MEET MANAGER. Both MEET 

MANAGER and SwimDive can be configured to work with different timing systems and 

different types of scoreboard data. From the main menu click Port. A window labeled 

SwimDive Setting will open. About half-way down is a setting that is labeled use with:. Click 

the arrow to the right of the box to show the possible settings. As a tool to help configure the 

system look in the window directly under the use with:  to read what the setting for the other 

pieces in the system needs to be for that configuration to work. Each different choice in the 

use with: will have a different system setting.

http://hy-tekltd.com/
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MENU-COMM PORTS 
RTD PORT: RTD*  

MENU-COMM PORTS 
RSLT: OMNI  2000* 

Section 2: OmniSport 2000 Connections Setup 

If getting the most out of a system while being easy to operate is important, the OmniSport 2000 

timing system is the best choice. This section explains the setup of the OmniSport2000 timing 

console. Configuring Hy-Tek’s MEET MANAGER to talk with the OmniSport 2000 and connect the 

OmniSport 2000 to the Venus 7000 or Venus 1500 controlled display. Refer to DWG-0531161 for 

OmniSport 2000 system configurations. 

 

Reference Drawings 

Omni 2000 System Configurations (Venus 7000) ............................................. Drawing B-531161 

Omni 2000 System to Galaxy via Wired Ethernet (Venus 1500) ...................... Drawing B-262403 

Omni 2000 System to Galaxy via Fiber Ethernet (Venus 1500) ....................... Drawing B-603918 

 

Note: Actual Com Port numbers may vary depending on which Com Ports are available on the 

computer in use. 

2.1 OmniSport 2000 Settings 

If the OmniSport 2000 console is sending data to a Venus 7000 or Venus 1500 controlled 

display, the console will be configured the same regardless. Every OmniSport 2000 console 

has two connections, one to MEET MANAGER and one to the Venus 7000 or 1500 controlled 

display. 

1. Turn on the OmniSport 2000 timer and enter the date and time and select Swimming. 

Note: If the OmniSport 2000 Pro Swimming software is being used, skip to Step 3.  

2. From the Main Menu on the OmniSport 2000 console, 

press [4] Setup > [4] Comm Ports > [2] RTD Port. Verify 

the right LCD on the LCD OmniSport 2000 console 

displays RTD Port: RTD. If not press [→] once for the  

RTD setting. After the console is set to RTD, press [Enter]. 

3. Line two on the right LCD screen will display   

3-Results Port. Press [Enter]. 

4. Line two on the right LCD screen will display RSLT: 

OMNI 2000. If the LCD reads a different setting, press 

[→] until it reads OMNI 2000 then press [Enter]. 

5. Connect a serial cable from J6 (Results) on the back of the control console to a Com Port 

on the computer with Hy-Tek software. 

 

 

MENU-COMM PORTS 
3-RESULTS PORT 
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2.2 Hy-Tek MEET MANAGER Settings 

Every OmniSport 2000 console connects to a separate computer running Hy-Tek MEET 

MANAGER. In special situations when more information is needed, an additional feed direct 

from Hy-Tek to the Venus 7000 computer may be set up. For Extended Requests refer to 

DWG-531161 for these settings. In order to run more than one computer with Hy-Tek MEET 

MANAGER, the Pro Network/Internet option must be purchased.  

Configuring the Timing Console Interface to the OmniSport 2000 console: 

1. From the main menu of MEET 

MANAGER, select Set-up > Timing 

Console INTERFACE (Figure 2). 

2. Next select Daktronics OmniSport 2000 

from the list and click OK. 

Configure the Alpha Scoreboard 

INTERFACE to Daktronics: 

1. From the main menu of MEET 

MANAGER, select Set-up > Alpha 

Scoreboard INTERFACE. 

2. Next, select Daktronics from the list and click OK. 

Configure the Com Port in MEET MANAGER to connect the OmniSport 2000: 

1. From the Run menu of MEET MANAGER, select Interfaces > Timer (Dak 2) >  Open / 

Close Serial Port for Dak 2 (Figure 3).  

 

 

 

 

Figure 2: Hy-Tek's Swim MEET MANAGER 

 Figure 3: Run the Meet 
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2. Enter the Serial Com Port that will be used 

to connect MEET MANAGER to the 

OmniSport 2000 console then click OK 

(Figure 4).  

3. As long as everything is connected and 

configured correctly, a window will 

appear displaying Communications Passed. 

If communication does not pass verify 

that the correct Com Port number was 

entered and the correct cable is connected 

to the OmniSport 2000 console and that it 

is powered on and in the Swimming mode. 

Additional Hy-Tek for Extended Requests 
In some instances, additional data may need to be posted without interrupting the current 

results. Setting up a direct connection through an additional Hy-Tek computer can achieve 

this. However, the connection from Hy-Tek to the Venus 7000 computer will be different. 

Instead of going through the OmniSport console, a null modem cable will connect a Com 

Port on the Hy-Tek computer to a Com Port on the Venus computer. Also, the Hy-Tek 

computers will be networked together and must have the Pro Network/Internet option. 

Refer to DWG-531161 for the settings. 

2.3 Venus 7000 Control System 

Refer to DWG-531161 for a general system layout with 

the OmniSport 2000 connected to a Venus 7000.  

To set up the RTD inputs in the Venus 7000: 

1. Click Configure from the Venus 7000 shell  

(Figure 5). 

2. Click the RTD Inputs tab (Figure 6).  

3. Double-click on the input needed to configure. 

 

 

 

 

 

 

 
 

Figure 4: Select Serial Port for DAK2 

Figure 5: Venus 7000 Shell 

 

Figure 6: System Configuration 
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4. Refer to the settings in Figure 7 for an OmniSport 

2000 console input. The only settings that change 

between inputs are the Source and possibly the 

Default Input Template. If an input for the Extended 

Requests needs to be set up, refer to DWG-531161.  

An Input Template File (ITF) filters the data 

coming in on the input port and determines the 

start position and length of RTD fields in the data 

stream. To access and save the file, go to 

http://dakfiles.daktronics.com/downloads/Sports

_Products/OmniSport%202000/   

and right-click the appropriate sport (Figure 8). 

Click Save Target As… and save as type Input 

Template in the “D:\V7000” folder. 

 Connect the J5 (RTD) 

connecter on the 

OmniSport 2000 console to 

the desired RTD input on 

the Venus 7000 computer. 

In some instances the 

OmniSport console may be 

sitting next to the Venus 

7000 computer and a W-

1267 (9-pin male to female) 

cable can be used between 

the OmniSport console and 

a Com Port on the Venus 

computer. 

 In other instances, the 

OmniSport 2000 console 

and Venus computer may 

have some distance between them. In this case the OmniSport console may plug into 

a wall plate (J-box) at its location. The wiring from the OmniSport console‟s wall 

plate then runs to a wall plate at the Venus 7000 controller location. Due to the 

distance, current loop communications should be used. Connect a signal converter to 

the wall plate at the Venus 7000 control location and connect the Com Port on the 

Venus computer to the signal converter.  

5. Test communications. 

 Click Diagnostics from the Venus 7000 shell, select the RTD tab. Select the Input just 

created and click Template View. On the OmniSport console, start the time and view the 

time running in Template View. If the running time does not appear, check the settings 

and cable connection. 

4. To create the RTD display sequences, refer to Section 5. 

 

Figure 7: Edit RTD Input 

 

Figure 8: Save V7000 ITF File 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/
http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/
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SwimDive Request II 
1. From the main screen of the SwimDive Request II 

program (Figure 9), click the Port button near the 

bottom of the window to open the SwimDive Setting 

screen (Figure 10).   

 Port Number: is the Venus 7000 RTD input number 

the OmniSport 2000 console is connected to (refer 

to Figure 6). 

 Port Name: is any name for the selected port that 

makes sense to the user. Ex: POOL ‘A’. 

  Sign Service:  when the Venus 7000 controller and 

SwimDive Request II are on the same computer, 

type “. “ (period) If SwimDive Request II is on a 

computer other then Venus 7000 computer, type the 

name of the desired network sign service to connect. 

 Use with should display OmniSport 2000. If the system 

has been setup to have an additional Hy-Tek for 

extended Requests, see DWG-531161 for the settings.  

2. Test communications.   

From the Venus 7000 shell, click the Diagnostics RTD tab, select Input and click 

Template View. In SwimDive Request II, select Start List for Request Type and click 

Request. Information should come across in Template View. If not, check settings in the 

Venus 7000 computer and SwimDive Request II and check cable connections. 

 

2.4 Venus 1500 Controlled Displays 

The primary OmniSport 2000 console will be 

connected via current loop communications directly  

to TB1 pins 2 and 6 on the M2 or M3 Controller in the 

display. (M2 or M3 varies depending on the display 

model). Any additional OmniSport 2000 consoles will 

connect to the Ethernet network that is connected to 

the display. Refer to DWG-262403 or 603918.  

Input Template Files 
An Input Template File (ITF) consists of multiple Real Time Data fields that select the start 

position and length of RTD fields in a data stream. To access and save these files, first go to 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/.  

Right-click the appropriate sport (Figure 8), then Click Save Target As… and save as type Input 

Template in “C:\Program Files\Daktronics\Common\Input Templates” (Figure 11).  

 
Figure 9: SwimDive Request II 

 
Figure 10: SwimDive Settings 

 

Figure 11: Venus 1500 ITFs 

http://dakfiles.daktronics.com/downloads/Sports_Products/OmniSport%202000/
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1. Using the M2Config application, verify the settings for ports 1-4. Select Network > 

Configure Connection. If there is a Debug port setup, make sure to delete it, as it will 

interfere with sending RTD.  

Port 1  

Type: Direct 

Baud Rate: (19,200 for Galaxy Displays) 

  (115,200 for Galaxy Pro Displays) 

Number: 1 

Protocol: Venus 1500 

 

Port 2  

Type: TCP/IP 

Number: 3001 

Protocol: Venus 1500 

 

Port 3  

Type: UDP/IP 

Number: 3002 

Protocol: Daktronics RTD 

 

Port 4  

Type: Direct 

Number: 2 

Protocol: Daktronics RTD 

Baud Rate:  19,200 

 

2. Connect the OmniSport 2000 RTD port to the display. 

3. Test the connection from the OmniSport 2000 to the scoreboard display running an RTD 

sequence showing the running time from the console. Refer to Section ‎5.2 on how to 

make Venus 1500 sequences. 

4. If nothing shows on the display, check: 

 Is the sequence playing created by using a custom ITF (OS2_swimming.ITF)? 

 Are the ports set up correctly for the display (see Step 3 above)? 

 Is it connected to the J5 (RTD) port on timing console? 

 Are the settings in the OmniSport 2000 console correct? 

 Does the wire terminate correctly in the J-box and on the display? 

 If the OmniSport 2000 console is connected via Ethernet, verify that everything is 

plugged in and set to the correct TCP/IP addresses. 
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Section 3: Daktronics Matrix Displays with  
Colorado Timing Systems 

This section assumes that the scoreboard output in the Colorado Timing System (CTS) timer is set 

to its default settings and that the CTS timer and Hy-Tek’s MEET MANAGER are already 

communicating. 

 

First the MEET MANAGER needs to be configured for communications to the Venus 7000 or Venus 

1500 Real Time Data. After that there will be separate sub sections to configure the Venus 7000 or 

Venus 1500 controlled display. 

 

Reference Drawings: 

Colorado Timing System Configurations ...................................................... Drawing B-539079 

Colorado Timer to Galaxy via Wired Ethernet .............................................. Drawing B-604064 

Colorado Timer to Galaxy via Fiber Ethernet ............................................... Drawing B-604462 

Colorado System 6 to Galaxy via Ethernet Show Control .......................... Drawing B-1036117 

Colorado Sys 6 to DMP-7000; with Auto Start List..................................... Drawing B-1075312 

 

Note: Actual Com Port numbers may vary depending on which Com Ports are available on the 

computers used. 

3.1 Hy-Tek’s MEET MANAGER Settings 

For each timing console that is timing a swimming event, there will be a computer running 

Hy-Tek‟s MEET MANAGER. Each computer will provide the start list, results and team 

scores for that pool. In special situations where more information is needed, an additional 

feed direct from a second Hy-Tek computer to the Venus 7000 computer may be set up for 

Extended Requests. Refer to DWG-0539079 for these settings.  

Note: In order to run more than one computer with Hy-Tek‟s MEET MANAGER, the MEET 

MANAGER must have the Pro Network / Internet option installed.  

1. Connect a null modem cable from the Hy-

Tek computer to the Venus computer. If the 

distance is greater than 50-feet, signal 

converters will be required.  

2. From the main screen in Hy-Tek, select  

Set-up > Alpha Scoreboard INTERFACE. 

Select Generic Serial from the list and click 

OK (Figure 12).  

3. From the main menu in Hy-Tek, select Run > 

Interface > Scoreboard (GENSER) > 

Configure Serial Port.  

 

 

 

Figure 12: Scoreboard Vendor 
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4. Enter the following information: Baud Rate: 

9600, Parity: Even, Data Bits: 7 and  

Stop Bit: 1 (Figure 13). 

5. From the Run screen in Hy-Tek, select 

Interfaces > Scoreboard (GENSER) > Open / 

Close Serial Port for GENSER. (Figure 14)  

Note: Actual Com Port numbers may vary 

depending on which Com Ports are available 

on the computers used.  

3.2 Venus 7000 Control System 

Refer to DWG-539079 for a general system layout 

with the CTS timer and Hy-Tek connected to a 

Venus 7000 control system. 

Venus 7000 Settings 
Configure the RTD inputs in the Venus 7000 

computer from the Venus 7000 shell.  Click Configure then select the RTD Inputs tab. 

Double-click on the desired Input to configure (Figure 6). Use the settings on DWG-539079 

to configure. 

SwimDive Request II 
If more than one RTD input is being used for 

results, SwimDive Request II can be opened 

multiple times with the settings for each desired 

port (Figure 15).   

1. Port Number: is the Venus 7000 RTD input that 

Hy-Tek is connected to. 

2. Port Name: is any name for the selected port 

that makes sense to the user. Ex: Pool A Results. 

3. Sign Service: is when the Venus 7000 and 

SwimDive Request II are on the same 

computer, type “.” (period). If SwimDive 

Request II is on a computer other than Venus 

7000, type the name of the desired network 

sign service to connect. 

4. Use with: should display Hy-Tek Generic Scoreboard. If the system has been set up to 

have an additional Hy-Tek for extended Requests see DWG-539079 for the settings.  

 

 

Figure 13: Configure Serial Port for Scoreboard 

 

Figure 14: Select Serial Port for GENSER 

 

Figure 15: SwimDive Settings 
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5. Test Communications. 

From the Venus 7000 shell, click the Diagnostics 

RTD tab, select the Input created and click 

Template View. In SwimDive Request II, select 

Start List for Request Type and click Request. 

Information should come across in Template 

View. If not, check settings. 

TimerInterface 2000 Settings 
1. On the main menu of the Timer Interface 2000 

program (Figure 16), click Add under the 

INPUTS: section.   

2. The Configure Input: window will open  

(Figure 17).  

Under the Select Timer: select Colorado Timer 

(Figure 18). Under Select Port: click Edit. 

 

 

3. The Enter Port Parameters window will  

open (Figure 19). 

 

Type the name of the input. For example: CTS 

#1. Under Port Type: Select COM Port (Figure 

20). 

Select the Port that the timer is connected to and 

configure the settings as follows:  

  Baud: 9600  

  Parity: Even  

  Data Bits: 8  

 Stop Bits: 2  

 

4. Click OK and the note shown in Figure 21 will 

appear. Click OK. After configuring an input, 

shut down the TimerInterface 2000 program and 

then re-start it for all of the settings to take 

effect.  

 

Figure 16: TimerInterface 2000 

 

Figure 17: Configure Input 

 

Figure 18: Select Timer 

 

Figure 19: Enter Port Parameters 

 

Figure 20: Com Port Settings 

 

Figure 21: Timer Interface Notification 
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5. After opening the Timer Interface 2000 program 

again, click Add under the OUTPUTS: section 

(Figure 22).  

6. The Configure Output: window will open  

(Figure 23). 

Under Select Input: select the previously 

configured input to receive the data.  (Example: 

1:CTS #1 – Com1,9600,8,Even)  

Under Select Output Type:, select Venus 7000 

Direct then click Edit under Select Port. 

 

 

7. Select the Venus 7000 RTD input port to send 

the data to and click OK (Figure 24).  

 

8. Click OK in the Configure Output: window to  

accept the new settings (Figure 25). 

9. The note shown in Figure 21 will appear. Click OK. After 

configuring an output, shut down the TimerInterface 2000 

program and then re-start it for all of the 

settings to take effect.  

 

 

10. The TimerInterface 2000 screen shows each 

configured input and output (Figure 26). 

For inputs from additional timing consoles, 

repeat steps 1-9, naming the next timer input 

CTS #2 with the correct Com Port and RTD 

input settings. Refer to DWG- 539079. 

 

11. For input settings when connecting a CTS 

System 6 to a Galaxy display via Ethernet and 

Show Control System, refer to DWG- 1036117. 

 

 

Figure 22: TimerInterface 2000 with Input 

 

Figure 23: Configure Output: 

 

Figure 24: Select Input 

 

Figure 25: Complete Output Settings 

 

Figure 26: TimerInterface with Input & Output 
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3.3 Venus 1500 Control System 

Refer to DWG-604064 and DWG-604462 for general system layouts with the CTS timer and 

Hy-Tek connected to a Venus 1500 controlled display. 

Venus 1500 Real Time 
 

1. Connect a 9-pin female to a 9-pin 

female null modem cable from the 

Hy-Tek computer to the Venus 1500 

(V1500) computer.  

2. Open V1500 Real Time by selecting 

V1500 Real Time icon from the 

Venus 1500 shell (Figure 27). 

Note: If the computer  

screen does not display 

 the Venus 1500 Real Time icon, call 

Daktronics to request a USB software 

key contact Customer Support. Refer 

to Section 6. 

The Venus 1500 Real Time Main 

screen will appear (Figure 28). 

3. Double-click on Input 2 and click 

Configure.  

4. On the Input Properties screen (Figure 

31) click Configure. From the 

Configure Input window (Figure 29) 

select Serial Com Port and type in a 

descriptive name (Ex: “Pool A 

Results”) then click OK.  

5. Select the Com Port number that the 9-

pin cable is plugged into on the V1500 

machine as the port number to edit. 

Refer to Figure 30 for the appropriate 

Com Port settings, and click OK when 

finished. 

 

 

 

 

Figure 27: Venus 1500 Shell 

 

Figure 28: Venus 1500 Real Time 

 

Figure 29: Configure Input 

 

Figure 30: Com Settings 
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6. Back on the Input Properties screen (Figure 

31) click ITF.  

The Select Input Template window (Figure 

32) will open. Click the drop down button 

in the upper right corner and click 

browse.  

7. Navigate to 

“C:\ProgramFiles\Daktronics\Common

\Input\Templates” and select 

HygenericStartResults.itf. If this file does 

not show up on the list it will need to be copied into the directory. Click OK. 

8. From the Input Properties screen (Figure 31) click Select Displays. Select the display that 

the data will be displayed on. Click the 

arrow to move it into the column labeled 

Authorized for RTD Input then click Close.  

9. If there is a second Hy-Tek computer, 

repeat Steps 1-7 but be sure to assign it to 

Input 4. 

Display RTD Inputs 
Use M2Config to connect to the sign and verify 

the ports are set correctly. 

Port 1 

Type: Direct 

Baud Rate: (19,200 for Galaxy displays) 

  (115,200 for Galaxy Pro displays)  

Number: 1 

Protocol: Venus 1500 

 

Port 2 

Type: TCP/IP 

Number: 3001 

Protocol: Venus 1500 

 

Port 3 

Type: UDP/IP 

Number: 3002 

Protocol: Daktronics RTD 

 

Port 4 

Type: Direct 

Number: 2 

Protocol: Daktronics RTD 

Baud Rate: 19,200 

 

Figure 31: Input Properties 

 

Figure 32: Select An Input Template 
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Timer Interface 2000 Settings 
 
1. From the main menu of the Timer Interface 2000 program (Figure 16), click Add under 

the INPUTS: section. 

The Configure Input: window will open (Figure 17).   

2. Under the Select Timer: select Colorado Timer (Figure 18). 

Under Select Port: click Edit. 

3. The Enter Port Parameters window will open (Figure 19). 

Type the name of the input. For example, CTS #1.  

Under Port Type: Select COM Port. 

Select the Com Port that the timer is connected to and configure the Baud to 9600, Parity 

to Even, Data Bits to 8 and Stop Bits to 2.  

4. Click OK and the note shown in Figure 21 will appear. Click OK. After configuring an 

input, shut down the TimerInterface 2000 program and then re-start it for all of the 

settings to take effect.  

5. After opening the Timer Interface 

2000 program again, click Add 

under the OUTPUTS: section 

(Figure 22).  

6. The Configure Output: window 

will open (Figure 33).  

Under Select Input: select the 

previously configured input to 

receive the data.  (Example: 1:CTS 

#1 – Com1,9600,8,Even)  

Under the Select Output Type: 

select Venus Enhanced RTD.  

Next, click Edit under Select Port. 

7. The Enter Port Parameters 

window will open (Figure 34). 

Type the name of the output.  

(Example: CTS #1) 

 

Figure 33: Configure Output: 

 

Figure 34: Enter Port Parameters 
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Under Port Type: select UDP/IP. 

Under UDP Port, type in 3002. 

8. Click OK in the Configure Output: 

window to accept the new settings 

(Figure 35). 

9. The note shown in Figure 21 will 

appear. Click OK. After configuring 

an output, shut down the 

TimerInterface 2000 program and 

then re-start it for all of the settings 

to take effect.  

10. The TimerInterface 2000 screen 

shows each configured input and 

output (Figure 36). 

11. To set up additional timing 

consoles, repeat step 1-10, naming 

the next timer input CTS #2 and 

enter an offset value of 10000 for the 

RTD Offset in the output 

configuration (Figure 33).   

 

 

Figure 35: Complete Output Settings 

 

Figure 36: TimerInterface 2000 Main Menu 
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Section 4: Daktronics Matrix Displays with  
Omega Timing Systems 

When interfacing an Omega timing system to a Daktronics matrix scoreboard, the timer in use needs 

to be identified. The timing console can be an OSM6 or an ARES 21. If the console is an ARES 21 

the next question is going to be if there is anything else connected to the scoreboard port and if yes, 

what is it? 

 

In the following sections, use the questions above to identify how to connect and configure the 

equipment to show information on the Daktronics matrix display. 

 

Reference Drawing: 

Omega Timing System Configurations ......................................................... Drawing C-536240 

 

Note: Actual Com Port numbers may vary depending on which Com Ports are available on the 

computers used. 

4.1 Hy-Tek MEET MANAGER 

For each timing console in use during a swimming event, there will be a computer running 

Hy-Tek MEET MANAGER. Each computer will provide the start list, results and team scores 

for that pool. In special situations where more information is needed, an additional feed 

direct from a second Hy-Tek computer to the Venus 7000 may be set up for Extended Requests 

Refer to DWG-536240.  

In order to run more than one computer with Hy-Tek MEET MANAGER, the MEET 

MANAGER system must have the Pro Network / Internet option installed. 

If the timing console being used is an ARES 21 with the scoreboard port set to Daktronics 

ERTD, refer to the following section. If the timing console is an OSM6 or ARES 21 with the 

scoreboard port set to UNT4 protocol, refer to the OSM6 or ARES 21 set to UNT4 section. 

Hy-Tek with the ARES 21 Set to Bi-directional 
 
1. From the main menu of Hy-Tek MEET MANAGER, select Set-up > Timing Console 

INTERFACE. Select ARES 21 Bi-Directional from the list and click OK. 

2. From the main menu select Set-up > Alpha Scoreboard INTERFACE. Select Daktronics 

from the list and click OK. 

3. To test communications, select Run from the Hy-Tek main menu. Click Interface > 

Timer Dak… > Open/Close Serial Port for Dak2. Enter the Com Port number used to 

connect Hy-Tek to the control console and click OK. If everything is configured correctly 

a window will appear showing communications passed.  
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OSM6 or ARES 21 Set to UNT4 
 
1. Connect a null modem cable from the Hy-Tek computer to the Venus computer. If the 

distance is greater than 50-feet, a signal converter will be required.  

2. From the main screen in Hy-Tek, select Set-up > Alpha Scoreboard INTERFACE. Select 

Generic Serial from the list and click OK (Figure 12).  

3. From the main menu in Hy-Tek, select Run > Interface > Scoreboard (GENSER) > 

Configure Serial Port.  

Enter the following information: Baud Rate: 9600, Parity: Even, Data Bits: 7 and  

Stop Bit: 1 (Figure 13). 

4. From the Run screen in Hy-Tek, select Interfaces > Scoreboard (GENSER) > Open / 

Close Serial Port for GENSER (Figure 14). 

4.2 Venus 7000 Settings 

If the timing console being used is an ARES 21 with the scoreboard port set to ERTD protocol, 

refer to the following section. If the timing console is an OSM6 or ARES 21 set to UNT4 

protocol, refer to the OSM6 or an ARES 21 set to UNT4 protocol section.  

Venus 7000 with ARES 21 Set to ERTD 
Refer to DWG-536240 for a general system layout with the Omega timers and Hy-Tek 

connected to a Venus 7000 control system. On the drawing there are two options for the 

timing consoles in the Pool A and Pool B sections. If the ARES 21 scoreboard output is set to 

ERTD, use Option 1 settings. SwimDive Request II is not available with this setup. 

1. Configure the RTD inputs in the Venus 7000. From the Venus 7000 shell, click Configure 

and select the RTD Inputs tab. Double-click on the desired Input to configure. Use the 

settings as shown on DWG-536240. 

2. Connect the ARES 21 SCBD port to the signal converter connected to the Venus RTD 

Input 1. It is recommended to use current loop communications between the ARES 21 

and Venus 7000. 

3. To test the system communication, select Diagnostics from the Venus 7000 shell. Click 

RTD and the RTD input then select Template View. On the Omega timer, start the time 

and the running time should come across in Template View. If not, check the settings and 

cable connection. 

Venus 7000 with an OSM6 or ARES 21 Set to UNT4 Protocol 
Refer to DWG-536240 for a general system layout with the Omega timers and Hy-Tek 

software connected to a Venus 7000 control system. On the drawing there are two options for 

the timing consoles in the Pool A and Pool B locations. If the timing console is an OSM6 or an 

ARES 21 with the scoreboard output set to UNT4, use the Option 2 settings. 
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To configure the RTD inputs in the Venus 7000 computer, click Configure from the Venus 

7000 shell and select the RTD Inputs tab. Double-click the desired Input to configure. Refer 

to DWG-0536240 for the appropriate input port settings. 

SwimDive Request II 
If more than one RTD input is being used for 

results, SwimDive Request II can be opened 

multiple times with the settings for each desired 

port (Figure 37).   

1. Port Number: is the Venus 7000 RTD input that 

Hy-Tek is connected to. 

2. Port Name: any name for the selected port that 

makes sense to the user. Ex: Pool A Results. 

3. Sign Service: is when the Venus 7000 and 

SwimDive Request II are on the same 

computer, type “.” (period). If SwimDive 

Request II is on a computer other than Venus 

7000 computer, type the name of the desired 

network sign service to connect. 

4. Use with: instead of showing Hy-Tek Generic Scbd, the Use with drop down  

box should show CST or OSM6 when using the Omega system. If the system has been 

set up with an additional Hy-Tek computer for Extended Requests, see DWG-536240  

for the settings.  

5. Test communications. 

From the Venus 7000 shell, click the Diagnostics RTD tab, select the Input created and 

click Template View. In SwimDive Request II, select Start List for Request Type and click 

Request. Information should come across in Template View. If not, check the settings. 

TimerInterface 2000 Settings 
 
1. From the main menu of the Timer 

Interface 2000 program (Figure 16), click 

Add under the INPUTS: section.   

2. The Configure Input: window will open 

(Figure 17). 

Under the Select Timer: select Omega 

ARES, OSM6 (Figure 38). Under Select Port:  

click Edit. 

 

 

 

Figure 37: Swim Dive Settings 

 

Figure 38: Configure Input 
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3. The Enter Port Parameters window will 

open (Figure 39).Type the name of the 

input, for example Omega #1. 

Under Port Type: select COM Port. Select 

the Com Port that the timer is connected 

to and configure the Baud to 9600, Parity 

to Even, Data Bits to 7 and Stop Bits to 2 

(Figure 40). 

4. Click OK and the note shown in Figure 

21 will appear. Click OK. After 

configuring an input, shut down the 

TimerInterface 2000 program and then 

re-start it for all of the settings to take 

effect.  

5. After opening the Timer Interface 2000 

program again (Figure 41), click Add 

under the OUTPUTS: section.  

6. The Configure Output: window will open 

(Figure 42). 

From the Select Input: section, select the 

input to get data from. (Example: 1: 

Omega #1 – Com 5,9600,7,Even)  

Under Select Output Type: select Venus 

7000 Direct. Next, click on the Edit 

button under Select Port. 

7. Use the spinner control to select the 

Venus 7000 RTD input to send data to 

and click OK. 

8. Click OK in the Configure Output: 

window to accept the new settings. 

9. The note shown in Figure 21 will appear. 

Click OK. After configuring an output, 

shut down the TimerInterface 2000 

program and then re-start it for all of the 

settings to take effect. 

 

Figure 39: Enter Port Parameters 

 

Figure 40: Enter Port Parameters 

 

Figure 41: TimerInterface 2000 with Input 

 

Figure 42: Configure Output: 
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10. The TimerInterface 2000 screen 

shows each configured input and 

output (Figure 43).  

For inputs from additional timing 

consoles, repeat steps 1-9, naming 

the next timer Omega #2 with the 

correct com port and RTD input 

settings.  Refer to DWG-536240. 

 

 

 

 

 

 

 

 

Figure 43: TimerInterface 2000 
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Section 5: How to Create RTD Sequences 

5.1 Venus 7000 

1. Refer to Section ‎2.3 to verify the necessary Input Template Files are installed.  

2. Open the V7 Sequence Designer and create a 

new sequence for the appropriate sign 

 (File  New). 

3. Go to Frame > Insert > Data Frame.  

4. In the Frame Properties window (Figure 44), 

select the Data Field Parameters tab. Make 

sure the Field Type is set to RTD then select a 

previously created Input, either for the timer 

or for the Hy-Tek computer.  

5. Under Field Name, select from the list of 

available information. Use the Row 

and Col numbers (or click on the 

sequence) to adjust the position of 

the data field. 

6. To add another data field, simply 

increment Field in the top left corner 

of the Frame Properties window.  

 

Figure 45 shows a complete example 

of a Venus 7000 swimming sequence. 

7. After creating all of the required fields for the data 

frame, click OK. The sequence now contains two frames: 

the original Graphic Frame and the new Data Frame; the 

first Graphic Frame must be deleted. 

Go to Frame > Delete (or press [Ctrl + Del]). Then select 

the range 1 to 1 (Figure 46). Click Delete Range and then 

click Close. There should now only be one frame, the 

Data Frame and the RTD fields it contains.  

8. Click the preview button  (or press [F5]). As long as the input source is powered on 

and in operation, the correct data should show up in the proper location on the sequence. 

Make any adjustments to the RTD fields or input connections as needed. 

9. Save the sequence.  

 

 

 

Figure 44: Frame Properties 

 

Figure 45: V7 Swimming Sequence 

 

Figure 46: Delete Frame 
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5.2 Venus 1500 Version 3.12 

1. Begin by opening the V1500 Message Studio from the V1500 shell. Select File > New and 

select the sign for the new RTD sequence.  

2. Next, a Graphic Frame must be added. To do this, select menu item Frame >Add > 

Graphic. Graphic Frames are preferred for RTD because they allow positioning of the RTD 

boxes exactly where the user desires.  

Note: In the Sample Text field, the user can enter the text that will help to identify the 

information to show on the frame. By default, the data fields show “S’s” as sample text.  

The Justify option buttons will override the justification settings in the ITF file. This 

feature is available only when inserting an RTD field in a graphic frame for display with 

Version 3 controllers. 

3. To add an RTD field, go to Data Fields > 

Real Time Data, or select the 

RTD icon from the left hand pane.  

 

Click anywhere in the Graphic Frame and 

an RTD Field Properties window will open.  

4. At the top, click the drop-down list box 

and select a previously configured input. 

Alternately, select Custom ITF and then 

the browse button. Search for and select 

the correct ITF for the sport/interface and 

then click OK.  

 

After selecting an input or Custom ITF, a 

list of available data from the port will 

populate (Figure 47). Once the desired field type and parameters are chosen, click Add to 

set the field to the frame. Then click Close and change the style and alignment of the field 

boxes inside the frame. The user can now preview the frame but only as long as the input 

source is powered on and in operation. 

 

Refer to Figure 48 as an example of a swimming sequence. 

 

 

 

Figure 47: Add RTD Field  
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5. On the right there should be a 

story board with two frames, a 

blank Text Frame and a second 

Graphic Frame with RTD 

information. The first frame 

must be deleted in order for 

the sequence to display 

correctly. At the story board, 

right click on the blank Text 

Frame > Delete Frame(s). 

There should only be one 

frame left: the Graphic Frame 

with RTD information. 

6. The frame duration should 

also be changed from a couple seconds to a couple hours; this ensures the running time 

will not skip. In the lower left hand corner of the frame, see where it says Frame Duration, 

change the [Min] to [Hr]. 

7. To save the message: 

 Open the File menu 

and select Save. 

 In the Save 

Message dialog 

box, click on the 

plus sign next to 

the display type to 

open the library 

containing the 

folders.  

 Select the folder 

where the message 

will be saved in 

and type in the name, for example “OS_2000_Swim” (Figure 49). 

 Click Save. 

 

 

 

Figure 48: Swimming Sequence Example 

 

Figure 49: Save Message 
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Section 6: Daktronics Exchange and Repair & 
Return Programs 

6.1 Exchange Program 

The Daktronics Exchange Program is a quick, economical service for replacing key 

components in need of repair. If a component fails, Daktronics sends a replacement part to 

the customer who, in turn, returns the failed component to Daktronics. This not only saves 

money but also decreases equipment downtime. Customers who follow the program 

guidelines explained below will receive this service. 

Before Contacting Daktronics 
Identify these important numbers: 

Display Serial Number: _________________________________________________________  

Display Model Number:_________________________________________________________  

Contract Number: ______________________________________________________________  

Date Installed: _________________________________________________________________  

Daktronics Customer ID Number: ________________________________________  

 

To participate in the Exchange Program, follow these steps. 

 

1. Call Daktronics Customer Service.  

 

Market Description Customer Service Number 

Schools (primary through community/junior colleges), 

religious organizations, municipal clubs and community 

centers 

877-605-1115 

Universities and professional sporting events, live events 

for auditoriums and arenas  

866-343-6018 

 

2. When the new exchange part is received, mail the old part to Daktronics. 

If the replacement part fixes the problem, send in the problem part which is being 

replaced. 

a. Package the old part in the same shipping materials in which the replacement 

part arrived. 

b. Fill out and attach the enclosed UPS shipping document. 

c. Ship the part to Daktronics. 

 

3. A charge will be made for the replacement part immediately, unless a qualifying 

service agreement is in place. In most circumstances, the replacement part will be 

invoiced at the time it is shipped. 

 

If the failed part or replacement part is not returned to Daktronics within 3 weeks of 

the ship date, Daktronics will assume that the customer is purchasing the 

replacement part and will send an invoice for the value of the new sale part.  
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If the part or parts are returned within 2 weeks of the second invoice date, Daktronics 

will credit the customer for the second invoice. If after 2 weeks Daktronics has still 

not received the parts back, the customer must pay the second invoice and will not 

be credited for the return of the failed part. 

Repair & Return Program 
For items not subject to exchange, Daktronics offers a Repair & Return Program. To send a 

part for repair, follow these steps: 

1. Call or fax Daktronics Customer Service:  

Refer to the appropriate market number in the chart listed on the previous page. 

 

2. Receive a Return Materials Authorization (RMA) number before shipping. 

This expedites repair of the part. 

 

3. Package and pad the item carefully to prevent damage during shipment. 

Electronic components, such as printed circuit boards, should be placed in an 

antistatic bag before boxing. Daktronics does not recommend using packing 

„peanuts‟ when shipping.  

 

4. Enclose: 

 name 

 address 

 phone number 

 the RMA number 

 a clear description of symptoms 

Shipping Address 
Daktronics Customer Service 

RMA # 

201 Daktronics Drive, Dock E 

Brookings, SD 57006 

 

Fax: 605-697-4700 
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Appendix A: Reference Drawings 

Omni 2000 System to Galaxy via Wired Ethernet (Venus 1500) .............................. Drawing B-262403  

Omni 2000 System Configurations ............................................................................ Drawing B-531161 

Omega Timing System Configurations ...................................................................... Drawing C-536240 

Colorado Timing System Configurations ................................................................... Drawing B-539079 

Omni 2000 System to Galaxy via Fiber Ethernet (Venus 1500) ............................... Drawing B-603918 

Colorado Timer to Galaxy via Wired Ethernet ........................................................... Drawing B-604064 

Colorado Timer to Galaxy via Fiber Ethernet ............................................................ Drawing B-604462 

Colorado System 6 to Galaxy via Ethernet Show Control ....................................... Drawing B-1036117 

Colorado Sys 6 to DMP-7000; with Auto Start List .................................................. Drawing B-1075312 

 

 



















CAT5E
(W-1384)

NOTE:
W-1384, CAT5E CABLE RUNS MUST BE
LESS THAN 250'.

- FOR RUNS GREATER THAN 250' USE
FIBER OPTIC CABLE OPTION.

LAPTOP COMPUTER

BY OTHERS

NETWORK
COM1 USB
PRINTER

HY-TEK COMPUTER

POOL 'A'

HY-TEK SETTINGS
TIMING CONSOLE INTERFACE: COLORADO
TIMING SYSTEMS (4,5, OR 6)
ALPHA SCOREBOARD INTERFACE: "GENERIC"
CONNECTION METHOD: SERIAL PORT

SCOREBOARD PORT PARAMETERS - RUNSCREEN
OPEN/USE SERIAL PORT: COM X
CONFIGURE SERIAL PORT
BAUD RATE: 9600
PARITY: EVEN
DATA BITS: 7
STOP BITS: 1

TIMER INTERFACE 2000
INPUT #1
NAME: CTS TIMER POOL A
PORT TYPE: COM PORT
PORT: COM X
BAUD: 9600
PARITY: EVEN
DATA BITS: 8
STOP BITS: 2

OUTPUT #1
SELECT INPUT: "1: CTS TIMER POOL A-COM 5, 9600, EVEN, 8"
SELECT OUTPUT TYPE: "VENUS ENHANCED RTD"
PORT: UDP/IP "3002" (FOR GALAXY SYSTEMS)
PORT: UDP/IP "21000" (FOR DMP 8000 SYSTEMS)

COM 1 SCBD

COLORADO
SYSTEM 5 OR 6

ETHERNET ROUTER 4
PORT
A-2520

DCS SETTINGS

PORT: 1
NAME:CTS Timer Pool A
SOURCE TYPE: COM PORT
BAUD RATE: 9600
PARITY: EVEN
DATA BITS: 8
DEFAULT INPUT TEMPLATE: "CTS INTERFACE SWIMMING"

PORT: 2
NAME: Hy-tek A
SOURCE TYPE: COM PORT
BAUD: 9600
PARITY: EVEN
DATA BITS: 7
DEFAULT ITEM TEMPLATE: "HY-TEK GENERIC SCBD INTERFACE CONTIGUOUS"

PORT: 3
NAME: Output
SOURCE TYPE: UDP/IP
SOURCE: 3002 (FOR GALAXY SYSTEMS)
SOURCE: 20001 (FOR DMP 8000 SYSTEMS)
DEFAULT ITEM TEMPLATE: "HY-TEK GENERIC SCBD INTERFACE CONTIGUOUS"

DCS ACTIVE FILE SETTINGS
PORT 1
CTS TO HY-TEK-A-START LIST REQUEST
PORT 2
HY-TEK GENERIC RTD TO CONTIGUOUS RTD

SWIM/DIVE REQUEST
NAME: Hy-tek A
PORT NUMBER 2
SIGN SERVICE: DCS
USE WITH: "Hy-tek GENERIC SCBD"

SERIAL
 CABLE

BY
OTHERS

W-1350 (6FT) NULL MODOM
J2

0A-1177-1029
RJ45 J-BOX

WIRE
COLORPIN#

WHT/ORG

GRN

1

3
2

4

6
5

7
8

WHT/BLU

WHT/GRN
ORG 

BLU

8-PIN RJ45

WHT/BRN
BRN

J2

USB
NETWORK

COM

USB

DCS
0A-1453-0035

TIMER INTERFACE
A-3309

0A-2122-0101

J2

J1
RS232
TX/RX

TB1
5+
6-

SC1 0A-1065-0173
JUMPERS
12-N 13-P
19-W

W-1446 (30FT)

W-1506 (5FT)

W-1267 (10FT)
SERIAL CABLES

A-2221
USB TO SERIAL

ADAPTOR
REFER TO
DETAIL "A"

SIGNAL CONVERTER TB1

TIP PIN6 CL(-)

SHANK PIN5 CL(+)

-COM PORT NUMBERS MAY CHANGE DEPENDING ON COMPUTER SETUP

-THE ABOVE CONFIGURATION WILL AUTOMATICALLY SEND THE "START LIST" (SWIMMER NAMES) FROM
HY-TEK TO THE DISPLAY. THE KEY STROKE THAT TRIGGER'S THIS, IS THE "NEXT EVENT" OR "NEXT HEAT"
BUTTON ON THE CTS TIMER.

-TIMER INTERFACE AND DCS MUST BE OPENED BEFORE CTS SCBD SIGNAL CABLE IS PLUGGED IN. IF THE
STARTUP IS NOT FOLLOWED, WINDOWS WILL DETECT THE SERIAL DEVICES AS A SERIAL MOUSE.

-OPTIONAL SWIM/DIVE REQUEST SOFTWARE CAN BE USED FOR ALL REQUESTS. FOR EXAMPLE, START LIST,
EVENT RESULTS, TEAM SCORES.

-THIS CAN ALSO BE PUSHED FROM THE HY-TEK COMPUTER, USING THE "CNTRL+F" KEYS.

-THE FUNCTION KEY "LIST" IS FOUND IN HY-TEK, WHEN IN THE "RUN" SCREEN, UNDER "HELP/ SHORTCUTS".

-USE HY-TEK VERSION 5.0 DB OR HIGHER FOR NETWORK CONNECTION METHOD.

ALL EQUIPMENT IS SHOWN WITHIN 10 FT OF EACH OTHER

A-1801
USB TO
SERIAL

ADAPTOR

CTS 1/4" MONO OR
DAK 1/4" STEREO

DETAIL "A":

NOTE: IMPORTANT TO MAKE
SURE THIS NAME IS ENTERED
EXACTLY AS SHOWN IN TEXT

GALAXY
DISPLAY

OR
DMD DISPLAY

CENTRAL
NETWORK

CABLE/RJ-45 J-BOX
CONNECTION DETAIL

CAT5E
(W-1384)

LAPTOP COMPUTER

BY OTHERS

NETWORK
COM1 USB
PRINTER

HY-TEK COMPUTER

COM 1 SCBD

ETHERNET ROUTER 4
PORT
A-2520

W-1547 (20FT)

SERIAL
 CABLE

BY
OTHERS

J2

DCS
0A-1453-0035

TIMER INTERFACE
 A-3309

J2

J1
RS232
TX/RX

TB1
5+
6-

SC1 0A-1065-0173
JUMPERS
12-N 13-P
19-W

W-1446 (30FT)

W-1506 (5FT)

W-1267 (10FT)

A-2221
USB TO SERIAL

ADAPTOR

ALL EQUIPMENT IS SHOWN WITHIN 10 FT OF EACH OTHER

GALAXY DISPLAY
OR

DMD DISPLAY
CENTRAL NETWORK

POOL 'A'

HY-TEK SETTINGS
TIMING CONSOLE INTERFACE: COLORADO
TIMING SYSTEMS (4,5, OR 6)
ALPHA SCOREBOARD INTERFACE: "GENERIC"
CONNECTION METHOD: UDP ETHERNET

SCOREBOARD PORT PARAMETERS - RUNSCREEN
SET UDP PORT AND IP ADDRESS
PORT: 20001
IP: 192.168.0.122 *MUST MATCH COMPUTER RUNNING DCS SOFTWARE*

TIMER INTERFACE 2000
INPUT #1
NAME: CTS TIMER POOL A
PORT TYPE: COM PORT
PORT: COM X
BAUD: 9600
PARITY: EVEN
DATA BITS: 8
STOP BITS: 2

OUTPUT #1
SELECT INPUT: "1: CTS TIMER POOL A-COM 5, 9600, EVEN, 8"
SELECT OUTPUT TYPE: "VENUS ENHANCED RTD"
PORT: UDP/IP "3002" (FOR GALAXY SYSTEMS)
PORT: UDP/IP "21000" (FOR DMP 8000 SYSTEMS)

DCS SETTINGS

PORT: 1
NAME:CTS Timer Pool A
SOURCE TYPE: COM PORT
PORT: COM X
BAUD RATE: 9600
PARITY: EVEN
DATA BITS: 8
DEFAULT INPUT TEMPLATE: "CTS INTERFACE SWIMMING"

PORT: 2
NAME: Hy-tek A
(DEFAULT SHOW CONTROL IP)
SOURCE TYPE: UDP/IP
SOURCE: 20001

PORT: 3
NAME: Output
SOURCE TYPE: UDP/IP
SOURCE: 3002 (FOR GALAXY SYSTEMS)
SOURCE: 20000 (FOR DMP 8000 SYSTEMS)
DEFAULT ITEM TEMPLATE: "HY-TEK GENERIC SCBD
INTERFACE CONTIGUOUS"

DCS ACTIVE FILE SETTINGS
PORT 1
CTS TO HY-TEK-A-START LIST REQUEST
PORT 2
HY-TEK GENERIC RTD TO CONTIGUOUS RTD

SWIM/DIVE REQUEST
NAME: Hy-tek A
PORT NUMBER 2
SIGN SERVICE: DCS
USE WITH: "Hy-tek GENERIC SCBD"

SERIAL CONNECTION METHOD NETWORK CONNECTION METHOD - USE HY-TEK VERSION 5.0DB OR HIGHER

NOTES SECTION

*OPTIONAL*
SWIM/DIVE
REQUEST

0A-1240-1021

*OPTIONAL*
SWIM/DIVE
REQUEST

0A-1240-1021

ABOVE SOFTWARE
ON SHOW CONTROL

ABOVE SOFTWARE
ON SHOW CONTROL

NOTE: IMPORTANT TO MAKE
SURE THIS NAME IS ENTERED
EXACTLY AS SHOWN IN TEXT

REV DATE: BY:
07 13 SEP 18 MTR

ADDED J-BOX DETAIL 

REV DATE: BY:
06 19 JUL 18 DDM

UPDATED SERIAL ADAPTOR FROM A-2221 TO A-1801
AND UPDATED TIMER INTERFACE FROM 01-3309 
TO A-3309

REV DATE: BY:
05 18 NOV 16 NCB

CHANGED LABELS ON CABLES

REV DATE: BY:
04 22 FEB 16 MTR

ADDED NOTE IN NOTE SECTION. UPDATED NOTES IN
SERIAL & NETWORK CONNECTION METHODS DETAILS.

REV DATE: BY:
03 22 JAN 15 MTR

ADDED NETWORK CONNECTION METHOD

REV DATE: BY:
02 11 DEC 15 PJS

UPDATE PORTS' SETTINGS FOR
VERSION 5.1 AND HIGHER

REV DATE: BY:
01 09 NOV 11 AZH

UPDATE NOTES AND ADD SIGNAL CONVERTER,
MODIFY WIRING OF CTS AND HY TECH COMPUTER

EXISTING COLORADO
J-BOX 1/4" MONO JACK

TO DAKTRONICS FIXED
DIGIT DISPLAYS, SEE

DWG-130979 FOR DETAILS

REFER TO
DETAIL "A"

REPLACE EXISTING COLORADO
J-BOX 1/4" MONO JACK WITH

DAKTRONICS
0A-1009-0038 STEREO J-BOX

TO DAKTRONICS FIXED DIGIT
DISPLAYS, SEE DWG-130979

FOR DETAILS

COLORADO
SYSTEM 5 OR 6

120V AC
OR

230V AC

IF APPLICABLE

IF APPLICABLE

120V AC
OR

230V AC

NUC COMPUTER

THE CONCEPTS EXPRESSED AND DETAILS SHOWN ON THIS DRAWING
ARE CONFIDENTIAL AND PROPRIETARY. DO NOT REPRODUCE BY

ANY MEANS WITHOUT THE EXPRESS WRITTEN CONSENT OF
DAKTRONICS, INC. OR ITS WHOLLY OWNED SUBSIDIARIES.

COPYRIGHT 2018 DAKTRONICS, INC. (USA)
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DESIGN:

SCALE:

DIM UNITS:DATE: SHEET

DO NOT SCALE DRAWING
FUNC - TYPE - SIZE

DRAWN: -
JOB NO.

-

OMNISPORT 2000
COLORADO SYS 6 TO GLY/DMP8K VIA NET SHOW CENTROL

CENGELS

27 OCT 10

P1056 R 01 B

NONE

1036117
09

COM 2

USB

COM 2

DCS DIVING SETTINGS

PORT: 5
NAME: DIVING A
SOURCE TYPE: COM PORT
PORT: COM X
BAUD RATE: 9600
PARITY: EVEN
DATA BITS: 8
DEFAULT INPUT TEMPLATE: "OS2-DIVE"

PORT: 6
NAME: DIVING A - OUPUT
SOURCE TYPE: UDP
PORT: 21000

DIVING SERVER

IP ADDRESS: 0.0.1.0
GATEWAY: N
BITS FOR HOST: 0
SERVER IP: N
TELNET PASSWORD: N
DHCP DEVICE NAME: N

CHANNEL
BAUD RATE: 9600
I/F MODE: 4C
FLOW: 00
PORT NUMBER: 2100
CONNECT MODE: CC
DATAGRAM TYPE: 01
BROADBAST: Y
RENOTE PORT: 21000
PACT CNTROL: 00
SEND CHAR 1: 00
SEND CHAR 2: 00

REV DATE: BY:
08 9 JAN 20 MTR

ADDED DIVING SETTINGS AND SERVER NOTES

10/100
SERIAL

LANTRONIX
SCV #1

-DHCP
-19200W-1249

W-1446 (30FT)

DIVING NOTES:

*SET CTS CONSOLE COM 2 TO DAK ERTD

*USE DAKTRONICS AQUATICS DIVE A
PROFILE WHEN MAKING THE RTD
SEQUENCE

SHOW CONTROL
W/ DCS

USB
COM

NETWORK

0A-1403-1002

W-1506 (5FT)

REV DATE: BY:
09 19 MAY 22 MTR

ADDED NUC (A-4829592) DETAIL

SHOW CONTROL
W/ DCS

USB
COM

NETWORK

0A-1403-1002

W-1506 (5FT)

0A-2122-0101
NUC COMPUTER

USB
USB

COM

NETWORK
USB

NOTE 2:

3 STEP PROCESS TO CONFIGURE A-4829592 FOUND IN
0A-2122-0101

1) NAVIGATE TO TIMERINTERFACE.EXE APPLICATION IN
APPROPRIATE FOLDER AND RIGHT-CLICK, THEN SELECT
CREATE SHORTCUT

2) MOVE OR COPY/PASTE SHORTCUT FILE INTO FOLLOWING
FOLDER NAME:
C:\USER\USERNAME\APPDATA\ROAMING\MICROSOFT\WINDOWS\START
MENU\PROGRAMS\STARTUP

3) REBOOT COMPUTER TO CONFIRM START OF
TIMERINTERFACE

SEE NOTE 2 FOR
CONFIGURATION

SEE NOTE 2 FOR
CONFIGURATION
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